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Version 0.11

1)	The Output window has now gained its own pop up menu when the right mouse button is pressed.  Admittedly the pop up is not very big.



2)	The operation of the right mouse button has been improved slightly. If the cursor is placed over a selection then the selection remains.  Otherwise the cursor is moved.



3)	Parser Generator (PARGEN.EXE) can now take a project name as a parameter.  The project is then opened in preference to project used when Parser Generator was last run.



4)	The Paste and Delete commands are now enabled and disabled correctly.  They were enabled for read-only files, and disabled for modifiable ones.



5)	If a project option is now changed, source files will be rebuilt where the Build command is used.  Note that if only AYACC options are changed then only YACC files will be built.  Correspondingly, the same also applies to Lex files.



6)	The cursor in the editor windows, including the Output window is now moved correctly when the window is scrolled.



7)	Code generated by AYACC can now be compiled with Visual C++ version 1.52c. The problem occurred when the -d option (define header file) was used.  The #endif at the end of the file did not have a trailing newline.



8)	Another problem related to the -d option was the file name in the #ifndef statement generated at the top of the file. This has now been shortened to just the base name plus extension.  Note that the dot is replaced with an underscore.



9)	Help files have been modified. They are still not finished.



10)	The library has been updated. This also includes changes to the output that the AYACC and ALex tools generate.



Version 0.12

1)	Errors in the Output window that do not have a file name are now recognised as errors.  That is it is possible to select the error by double clicking it or through the use of the Next Error and Previous Error commands.



2)	It is now possible to compile files where there are spaces in the full path name of the file.



3)	The New Project dialog box can also handle spaces in the project path name. It will also prompt you to create any directories that do not exist.



Version 0.13

1)	Very simple grammars along the lines of:



a: ‘A’;



Would cause Parser Generator to output a C file, which could not subsequently be compiled.  The problem was caused by an un-initialised array.



2)	The Window menu has been revised.  It now has both a Tile Horizontally and Tile Vertically command as opposed to a Tile command.  It has also gained a Split command.



3)	The text displayed in the title bar has been changed slightly.  The colon ‘:’ has been replaced with a dash ‘-‘.  Project names ending in “.pgp” are shown without the extension.



4)	A Send command has been added to the File menu for electronic mail.



5)	A Select All command has been added to the Edit menu.  This selects the entire contents of the active editor window



6)	A Save All, Undo, Redo and Stop Build button have been added to the tool bar.



7)	The Status bar has been revised slightly.



8)	Help files have been modified.  They are still not finished.



9)	File drag and drop is now supported.  Note that this is not to be confused with the other more generalised form of drag and drop.  File drag and drop is where you drag a file from somewhere, i.e. Windows Explorer, and drop it in an application, in this case Parser Generator.



10)	When compiling a file you can now continue to interact with Parser Generator.  Before Parser Generator would appear to lock up.  Note that this was not particularly noticeable if you were compiling small source files.



11)	The editor now supports splitter windows.  You can have a maximum of 4 separate views in one frame window.  Support for splitter windows is provided by a Split command in the Windows menu.



12)	The error keyword is now recognised as such when syntax colouring.  Before it was recognised as an identifier.



13)	The editor window now updates correctly when syntax colouring.  This only applied to when a token crossed a line boundary, i.e. typing /* would not colour the next lines up to a terminating */.



14)	The cursor (caret) now hides itself correctly when you type some text.  Under some conditions it would not re-appear when the mouse was moved.



15)	The Editor Options dialog box has gained two more options. One controls whether you want the view to redraw when you are dragging the scroll box in a scroll bar.  The other controls whether you want to be prompted when automatically loading externally modified files.



Version 0.14

1)	Corrections made to the project rebuild mechanism again.  The previous implementation was not quite right.



2)	The setup program now registers the “.pgp” extension as a Parser Generator Project in the Registry.  You can now open Parser Generator projects from Windows Explorer by double clicking the icon.



Version 0.15

1)	The Output window now displays output from the AYACC and ALex tools.  This was for Windows NT machines only.



2)	The Cut command is now disabled for editor windows marked as read only.



3)	If no files were in a project and one of the build commands, either Build or Rebuild All was used then Parser Generator would enter a build process without starting to compiling a file.  As a consequence it would sit there waiting for this non-existent file to finish compiling.  This would mean that you could not close the project, or for that matter close the application.  This has now been corrected.



4)	It is no longer possible to use the Project New, Open, Edit, Close or Most Recent commands while a build is in progress.



5)	The Select All command did not work correctly.  The last line in the window was not always selected completely.  This has now been corrected.



6)	There were a number of bugs to do with the handling of errors in the Output window.  These related to modification of the source files containing the errors, scrolling of the windows, closing of source windows etc. In other words there were quite a few.  These should now all be fixed.



7)	The editor should now be able to deal with foreign keyboards. In particular this relates to accents over characters.  For instance an umlaut over an o.



8)	There were a number of minor problems with the display of information in the Status bar.  This included the READ pane not displaying the text when a read-only file was opened, and the line number and column panes showing 00000 and 000 respectively when a dialog box (i.e. the Line dialog box) was displayed.



9)	The editor now handles the overwrite mode correctly.  Before it treated both the insert and overwrite modes as one and the same.  This also includes special handling for the tab and return keys.



10)	When saving files an extra line feed/carriage return character pair was added to the end of the file.  As a result each time you saved a file it would grow by one (blank) line in length.  This has now been corrected.



11)	The Keep Tabs/Insert Spaces options in the Editor Options dialog box did not work.  Regardless of what was selected a tab would always be inserted.  This has now been corrected.



12)	When more than one line is selected, pressing the tab key will now cause the selected lines (except the last one) to be indented.  Note that if the shift key is held down, then the selected lines are un-indented.  An indent is assumed to be one tab stop in width.



Version 0.16

1)	The Tools menu is disabled (greyed) if there are no menu items in it.



2)	There was an occasional divide by zero error when an editor window was opened. This was introduced in version 0.15.  This has now been corrected.



3)	The macro parsing for tool arguments has been improved. It is no longer bothered with any trailing characters after the macro.  Before they had to be a non-alphabetic.



4)	The start state <*> at the front of a regular expression in ALex is now recognised.  This is really just a syntactic nicety.  The regular expression matched would be the same if <*> was omitted.  The resultant grammar used by ALex is:



start:

	< start-list >

	< * >



start-list:

	start-list , identifier

	identifier



5)	A macro could not be referred to in ALex if it began with an underscore.  For instance {_a} would generate errors if used in a regular expression.



6)	The comma “,” is not considered as an operator symbol now in ALex. Before you would have to escape it with back-slash ‘\’ if you wished to use it in a regular expression.



7)	Compound statements can now be nested in {…} actions in ALex and AYACC, i.e. {…{…}…}.



8)	If a % sign were embedded in %{…%} in ALex then it would cause a fatal-error.  This has now been corrected.



9)	It is now possible to have more than one start state at the front of a regular expression in ALex, i.e. <AA,BB>.  Before it would have caused a syntax error.



10)	The contents of the Find What box in the Find/Replace dialog boxes was not always filled out correctly when the corresponding dialog box was displayed.



11)	Character strings in Lex regular expressions were not being correctly syntax coloured by the editor.  This has now been corrected.



12)	Embedded actions in AYACC rules were not working correctly.  This applied to both the generated table code, and attribute access from the actions in question.  This has now been corrected.



13)	Some debugging code has been added to actions generated by AYACC.  This enables you to more easily inspect attribute values.  Note that this can only really be used if you are running the parser in a debugger.



Version 0.17

1)	If the verbose option -v and the compatible option -c are selected for AYACC then the generated verbose file is now “y_output”.  These options used to generate the file “y_output.v”.  Note the .v extension.



2)	The %{…%} sequence is now accepted by the AYACC parser when it is placed after the first %% mark.  That is in the rules section.  Note that the enclosed code is placed at the top of the parser action function.  This code will be run for every action that is executed.  This is in contrast to YACC, when the code is placed at the top of yyparse function.



3)	The %a, %e, %k, %n, %o, and %p internal array size declarations have now been implemented in ALex.  Note that these have no effect on how ALex operates.  They are solely there for portability purposes.  The resultant syntax that is recognised by ALex is:



array-decl:

	array-keyword integer-constant



array-keyword:

	%a

	%e

	%k

	%n

	%o

	%p



4)	The %option declaration has now been implemented in ALex.  Note that this declaration has no effect on how ALex operates.  It is solely there for portability purposes.  The resultant syntax that is recognised by ALex is:



option-decl:

	%option [option-list]



option-list:

	option-list identifier

	identifier



5)	The Save All command in the File menu no longer displays a dialog box every time it wants to save a file.  It only displays a File Save As dialog box when you have modified a file that does not yet have a file name associated with it.



6)	The %a, %e, %k, %n, %o, %p and %option ALex keywords are now syntax coloured by the editor.



7)	ALex hexadecimal and octal integer constants are now syntax coloured correctly by the editor



8)	For compatibility, new definitions of yyerrok and yyclearin have been added to the AYACC header file yacc.h.  Note that there are no parentheses after the names.  In order to use them you must define YY_COMPATIBLE.  In Visual C++ this can be done through the project options.



9)	The file loading speed in Parser Generator has been increased.  This is to cope with the rather large files that can be generated by AYACC and ALex.



10)	Action code in both AYACC and ALex now handle both line //… and block /*…*/ comments safely.  That is, it is possible to include { and } characters in them.



11)	Code enclosed in %{…%} in both AYACC and ALex can now handle both line //… and block /*…*/ comments, character constants ‘…’ and string constants “…”safely.  That is, it is possible to include %} character sequences in them.



12)	Union code in AYACC can now handle nested { and } characters.  These characters can also be included safely in both line //… and block /*…*/ comments, character constants ‘…’ and string constants “…”.



13)	Syntax colouring for YACC and Lex now takes into account { and } character nesting, line //… and block /*…*/ comments, character constants ‘…’ and string constants “…” in actions, union code and %{…%} delimited code.



14)	The ALex generated lexical analyser now has growable text (with accompanying state) and unput buffers.  By default the buffers will grow if they should overflow.  Setting yytextgrow and yyunputgrow to zero can disable this.



16)	Whenever a syntax error is encountered yyerror is now always called with “syntax error”.  It used to be that it would only be called if no error production were encountered during error recovery.  In these circumstances, the parser (yyparse or yycparse) would then have returned immediately with an error code.



15)	There have been a number of other minor modifications to the library and generated lexical analyser/parser code.  Most notably is the addition of stack/buffer controlling functions and error condition functions.



16)	An undeclared start state in ALex would have caused the program to crash.  This has now been corrected.



17)	Parser Generator had some trouble displaying certain fonts in the editor and Output windows.  This has now been corrected.



Version 0.20

1)	Parser Generator can build Simpler LR (SLR) parsers successfully now.  Before, AYACC would issue a General Protection Fault if it ever tried to do so.



2)	Compact parsers can now be compiled without any errors.  Changes made in an earlier version of Parser Generator (in particular the library) introduced this bug.



3)	In line with AYACC, ALex can now generate a compact lexical analyser.  This is achieved through the new -s option.  There has also been a corresponding change in the ALex Options dialog box to support this.



4)	One of the major changes in version 0.20 is the ability to generate multiple parsers and lexical analysers for inclusion in a single executable.  This is achieved through the use of a structure that holds all of the parser/lexical analyser’s variables, service functions and tables.



Both AYACC and ALex have gained a new -m option to generate multiple style parsers and lexical analysers.  Both these options are implemented in the relevant tool options dialog boxes in Parser Generator.



One of the drawbacks to the introduction of multiple parsers/lexical analysers was the need to effectively duplicate the contents of the YACC and Lex library.  There are now one set of function for single parsers/lexical analysers and another set of files for multiple parsers/lexical analysers.  Functions that are associated with multiple parsers/lexical analysers have the prefix "yym" as opposed to "yy".



In order to make each parser/lexical analyser unique it was necessary to introduce some new syntax to AYACC and ALex:



name-decl:

	%name identifier



All it does is simply assign identifier as the name of the generated (structure) variable.



5)	The output filename extension can now be specified as either .c (the default) or .cpp for both AYACC and ALex.  Note that this different to the -o option, which allows you to specify the entire output filename.  This option is really intended for the AYACC and ALex Options dialog boxes.  The actual options to pass to the tools themselves are -ec and -ecpp.



6)	ALex can now generate case insensitive lexical analysers through the use of the -u option.  This is a slight shortcut since it allows you to simplify your lex files.  For instance:



[gG][oO][tT][oO]



could be replaced by:



goto



if the -u option were used.  The option is also present in the ALex Options dialog box.



7)	The other major enhancement to version 0.20 is the addition of nonterminal destructors.  They are quite simple when you know what they are for.  If a YACC generated parser encounters a syntax error it enters error recovery.  What it does here is pop symbols off of the stack until it encounters a state in which there is an error token transition, i.e. it can enter an error production.  Unfortunately in the mean time, we may have popped some non-terminal symbols off of the stack.  If we had been building a node tree, then we may find that we have lost some nodes on the heap.  These losses may not be particularly important if we have a program which runs and then exits, however if the program is continually processing input then we may have a problem.  Note that there are ways around using nonterminal destructors, but they are not particularly nice.  The grammar fragments for nonterminal destructors are shown below.  There are two different types, one for "normal" nonterminals and the other for embedded actions (which generate an invisible nonterminal):



rule:

	nonterminal : production-list ;

	nonterminal-destructor-list : action ;



nonterminal-destructor-list:

	nonterminal-destructor-list | ~ nonterminal

	~ nonterminal



symbol:

	nonterminal

	token

	action [~ action]



Note that several nonterminals can be tied to one action.  To access the nonterminals attribute use $$ in the action.  See also yywipe and yymwipe in the YACC and Lex library.



8)	Alex can now generate a header file.  This is achieved through the -i option.  The ALex Options dialog box supports this new option as well.



9)	The About dialog box has been revised slightly.  It now has a large icon and displays the physical memory available, whether there is a co-processor or not and the disk space or the current drive.



10)	The digit zero '0' in a regular expression is now treated as a character by the syntax colouring algorithm.  Parser Generator used to think that the 0 was introducing a hexadecimal or octal number and colour it accordingly.



11)	The navigation of errors in the Output and source windows has been revised slightly.  If the cursor is over an error in the Output window, then pressing the ENTER key will select the error and take you to the corresponding line in the source file (if there is one).  If on the other hand you press the SPACE bar then the error will be selected, however you will not be shown the corresponding point in the source file.



If the active source window contains a error, then pressing the ESCAPE key will remove the marking.



12)	The lex header file lex.h had a function declaration error.  The function yylexaction() should have been declared as:



#if defined(__STDC__) || defined(__cplusplus)

int YYCDECL yylexaction(void);

#else

int YYCDECL yylexaction();

#endif



Instead of:



int YYCDECL yylexaction(int action);



13)	The macro YYEXTERN_C was redundant and has now been removed all YACC and Lex library source files, and from any generated parser and lexical analyser code.  In fact it was potentially dangerous and could lead to variable declarations where definitions were required.



Version 0.21

1)	There was a bug in the yacc.h header file in version 0.20.  The following was defined:



#ifndef YYFAR

#define TTFAR

#endif



When it should have been:



#ifndef YYFAR

#define YYFAR

#endif



2)	The YYCONST qualifier was accidentally removed from the yybackup array in the generated lexical analyser output file.  This occurred when the YYEXTERN_C's were being removed from all function and variable definitions in version 0.20.  It has now been added back again.



Version 0.30

1)	The Rebuild command in the Project menu was not working correctly when the default output file name extension was set to .cpp.  It was simply recompiling the YACC and Lex files whether they were up to date or not.



2)	The YACC and Lex action routines no longer contain empty switch statements if there are no actions placed in them.



3)	The last element in an array generated by AYACC and ALex no longer has a redundant trailing comma.  Note that most compilers will accept this comma.



4)	The -e option (used to specify the output file name extension), is only used if neither the -o or -c options are used.  This applies to both AYACC and ALex.



5)	The yymlex_t structure now has a yymdata member as opposed to yydata.  Notice the presence of the "m".



6)	There is now a declaration for yymgettoken in the header file myacc.h.



7)	The functionality of yymgettoken has been revised.  It is now expecting the address of a yymlex_t variable to be assigned to yymdata.  The function takes this address and passes it to the function yymlex.



8)	Expressions in a Lex file can now share the same action.  Before a spurious left parenthesis was generated.  This prevented the output file from being compiled. For example:



a   |

b   { /* do something */ }



would have generated:



case 1:

    {

case 2:

    {

 /* do something */

    }

    break;



9)	Code embedded in %{...%} was not being output correctly in ALex.  The problem occurred around asterisks "*" in a C comment and the percent sign "%".



10)	The toolbar has been revised.  The About and context sensitive help buttons have been removed.  A Find combo box has been added and the Find button replaced with a Find Next and Find Previous buttons.



11)	The menus have been revised.  The Error command in the Help menu has changed to the Build Tools command.  There have also been changes to the accelerator keys for some of the commands.



12)	It is now possible to generate multiple instances of parsers/lexical analysers.  This has resulted in a modification to the -m option.  It now has three suboptions:



-ms: Single parser/lexical analyser

-mm: Multiple parser/lexical analyser

-mi: Multiple parser with multiple instances



These option changes are reflected in the Tool Option dialog boxes.  There has also been the introduction of four new functions to the YACC and Lex library to support multiple instances.  These are the function pairs yycreateparser/yydestroyparse and yycreatelex/yydestroylex.



13)	The loading of text files has been revised slightly again.  Now a new line is said to start on a carriage return '\r', line feed '\n' or carriage return '\r' line feed '\n' pair.  Note that a message box is displayed if lines separated by carriage return '\r' are found.



14)	The Compile File command has been made more secure.



15)	The Undo command was not working correctly.  It would auto-indent text where it was not necessary.  This has now been fixed.



16)	Workspace loading was not working correctly.  Minimised windows were always being made active.  It is now the topmost window that is always active, as it should be.



Version 0.31

1)	Table compression in AYACC has been significantly improved.  This applies to both the default (fast) tables and the compact tables.



1)	The verbose file generated by AYACC has been corrected and improved on.  It now provides additional information at the bottom of the file.  This includes any rules that are not reduced, and any shift/reduce and reduce/reduce conflicts that occurred in the grammar.



3)	The YACC action function yyforceerror (YYERROR) should now work correctly (if anyone uses it that is).



4)	Find and replace has been slightly improved.  When searching down the document, if the bottom is reached, then searching commences again at the top.  Correspondingly, when searching up the document, if the top is reached, then searching commences again at the bottom.



5)	Changing the Model in the AYACC and ALex Options dialog boxes will now cause the relevant files to be rebuilt if the Build command is used.



6)	File reloading after a tool has run has been improved.  The relevant file is now reloaded immediately after the Yes button in the message box is pressed, rather than after all message box prompts have been displayed.



7)	Error reporting in AYACC has been improved.  It now reports whether any rules have not been reduced, and whether any symbols have been declared, but not used in the grammar.



Version 0.32

1)	Improved support for Visual C++ Version 5.00.



2)	Improved support for Borland C++.



3)	Actions in Lex were not being copied correctly to the output file.  Actions which were not surrounded by brackets { and } were losing the first character in the action i.e. the action in the rule:



	"if" return IF;



	would have been copied to the output file as:



	eturn IF;



	Note the missing "r" in return.



4)	Keywords in both AYACC and Alex are no longer case sensitive.  This is for compatibility reasons.  For instance %Token and %TOKEN both specify the %token keyword.



5)	There are a number of extra synonyms for the %start keyword.  These are %st, %sta and %star.  Note that because keywords are no longer case sensitive, this also includes all upper and lower case variations of the keywords i.e. %St, %sT etc.



6)	The keyword %x (and %X) is now recognised by ALex.  It is simply a synonym for the %start keyword.



7)	The keyboard shortcuts for the Undo, Cut, Copy, Paste and Select All commands in the Edit menu now apply to the Find combo box in the toolbar when it has the focus.  Previously, the commands would be applied to the active view.



8)	There were are couple of mistakes in the conversion files miyconv.h and myconv.h.  

	In the file miyconv.h:

	#define yymenv (yy)->yymenv

	Should have been:

	#define yyenv (yy)->yymenv



	In file myconv.h:

	#define yymenv (YYPARSENAME).yymenv

	Should have been:

	#define yyenv (YYPARSENAME).yymenv



Version 0.40

1)	The structure jmp_buf, and its associated functions setjmp and longjmp, are no longer used by the parsers in the YACC and Lex library.  One of the reasons for doing this was to increase compatibility with version 1.52 of Visual C++ (it was only possible to compile parsers for C, not for C++).  This also has an effect on how yyaccept and yyabort (and their multiple counterparts) operate.  These functions no longer operate immediately, rather the accept or abort occurs when control returns to the parser from the user action.



2)	The Undo buffer was not working correctly.  In particular, if an operation would not fit inside the buffer and the operation was stopped, then the original state was not restored correctly.



3)	The Replace All button in the Replace dialog box was not working correctly.  Under some circumstances the application would lock up.  This bug was introduced in version 0.31 when the Find operation was revised so that it would cycle round to the top of the file after reaching the bottom.  Unfortunately, this was also used for the Replace All command.  The command would only stop when no more replacements could be made.  If the Find what string was a sub-string of the Replace with string, the application would loop endlessly.



4)	The yydiscard and yymdiscard functions have gained an extra parameter.  This is an int which indocates what token is actually being discarded.  The function prototypes are now:



void yydiscard(int token);

void yymdiscard(yymparse_t *yy, int token);



5)	The Registry is now used to store application information rather than the PARGEN.INI file in the Windows directory.



6)	The generation of #line statements in output files has been improved.  Where necessary, #line directives are generated to reset the mapping from the YACC or Lex file back to the output file.  For instance, the break (and possible case statement) following an action is part of the output file, and not the YACC or Lex source file.  The same can be said of any code generated by AYACC or ALex which is not directly related to the source.



7)	Table compression in ALex has been improved.  This is along the lines of the table compression used in AYACC.



8)	AYACC now recognises octal and hexadecimal integers.  The editor in Parser Generator has been modified so that it syntax colours the integers as well.  An octal integer starts with a zero and has one or more trailing octal digits.  A hexadecimal integer starts with 0x or 0X and has one or more trailing hexadecimal digits.



9)	There was a bug in the implementation of the yymore functionality in the lexical analyser.  The bug was not with the yymore function itself, but the code in the yylex, yyclex yymlex and yymclex routines.  If yymore was called in an action, and no regular expression could subsequently be matched, then the lexical analyser would behave erroneously.  Basically, in addition to looking for a matching state in the current string, it would go back through the entire string stored in yytext.



10)	Token recognition in AYACC has been revised.  Now an action, union code, program code %%… or code block %{…%} are considered as complete tokens.  Previously they were implemented as starting and end tokens (where applicable), with code contained within them eaten up separately.  This is inline with how tokens are implemented in ALex.



11)	The %x keyword (and %X) is no longer a synonym for the %start keyword.  Instead it indicates that the start state is an exclusive start state, as it should have done in the first place.  There is also a corresponding change to the meaning of <*> at the start of regular expressions.  This means, again as it should have done in the first place that the expression matches all start states, including exclusive start states.



12)	The syntax for regular expressions in ALex has been revised slightly.  Previous regular expressions will still be recognised correctly.  The changes occur for the left and right context operators, and make them slightly more flexible.  The new syntax is:



expression :

	left-context-expression



left-context-expression :

	< start-list > left-context-expression

	< * > left-context-expression

	^ left-context-expression

	right-context-expression



start-list :

	start-list , identifier

	identifier



right-context-expression :

	[union-expression] / union-expression

	[union-expression] $

	union-expression



13)	The implementation of the yylex and yyclex functions has been revised slightly.  This is so that they can fully backup a regular expression if need be.  This is inline with the new right context expression syntax that explicitly states that you can do so.  In the previous implementation, at least one character would always be left in the buffer.  Note that it was possible to specify expressions which backed up completely in the old version.  For instance, consider:



a?/bc   { /* backup completely on "abc" */ }



14)	The start state INITIAL is now implemented by ALex.  You can use the start state in left context expressions, and as a parameter to the yybegin function.  Note that this is equivalent to calling yybegin with 0.



15)	DFA compression logic in ALex has been improved to cope with backup expressions better.  Previously it was possible for a compressed state to lose or gain a backup expression.



16)	A couple of table compression bugs introduced in version 0.31 of AYACC have been fixed.  It was possible for a state to accidentally gain an action from another state.  This occurred when default states were being searched for.  Also the error handling code in the yyparse, yycparse, yymparse and yymcparse functions were not modified correctly to cope with the new table compression.



Version 0.41

1)	The code generated for a multiple instance model lexical analyser was slightly wrong.  The generated yymlex_t variable made reference to the defined symbol YYMPARSEDEBUGOUT.  In fact it should have made reference to YYMLEXDEBUGOUT.



Version 0.50

1)	Hex characters and octal characters are now allowed in character escapes.  A hex character is introduced with the escape sequence \xhh, where hh is one or more hex digits (0 - 9, a - f, A - F).  An octal character is introduced with the escape sequence \ooo, where ooo is one, two or three octal digits (0 - 7).  Hex and octal characters were already supported in character strings and character classes.



2)	$$ attributes were sometimes reported as untyped by AYACC.  Since these were only warnings it not prevent AYACC from generating parser code.  The error would only occur when the $$ attribute was used in an action for an empty production.  For example:



A: { $$ = 0; }

 ;



3)	ALex now provides full reject capabilities if required.  This is provided through the -r option.  If this is selected, then it is possible to match every regular expression.  Note that in order to do this you will need to use the yyreject function inside your actions.



4)	The YACC and Lex library has gained some extra functions.  These are yysetup, yywork, yycwork, yyretire and yyexit.  They are all parser functions and allow control to pass out of the parser and back again with no loss of information from the state and attribute stacks.



5)	The operation of the yyeol flag in the lexical analysers has been revised.  Now the flag is set after a string is matched, rather than on entry to the lexical analyser.  This allows the flag to be modified in an action, without it subsequently being changed.  Note that the flag indicates to the lexical analyser whether the previous character was a newline character or not.



6)	There was a possibility for the parser to access non-existent attribute stack memory.  This would only occur if the stack was full (and about to overflow), and a rule of the form below was reduced by the parser:



A: /* e */ { /* do something */ } ;



7)	When a project was moved between directories and then opened, the names of the files in the project were updated however they were never saved.  The Edit Project dialog box would show that the file names had appeared to change to the new directory.  However if you closed the project and then reopened it the dialog box would show the old file names instead.



8)	When the parser is in error recovery it now has to shift three consecutive tokens onto the stack before error recovery is completed.  Previously, it did not matter whether the tokens were consecutive or not.



9)	The default transition logic implemented for ALex did not work correctly.  If there was a state with a transition on every character (0 - 255), and all transitions went to the same (not necessarily different) state, then ALex would crash.  This has now been fixed.  In practice, it is very rare to have states which do this.



10)	Parser Generator now syntax colours C and C++ source files.  It also syntax colours the C/C++ source code which is embedded within a YACC and Lex file.



11)	The code generated for a multiple lexical analyser was slightly wrong.  Instead of saying #ifdef YYMLEXDEBUGOUT, it should have said #ifndef YYMLEXDEBUGOUT.



12)	There was a slight bug in the yacc conversion file MYCONV.H.  Instead of saying #define yyparsedebugout (YYPARSENAME).yyparsedebugout, it should have said #define yyparsedebugout (YYPARSENAME).yymdebugout.



Version 0.60

1)	The Replace All button in the Replace dialog box would not work correctly if Match whole word only or Match case was selected.  Basically, the functionality for the two check boxes was swapped over.



2)	If a find operation was started from either the top or bottom most line in the document, and no string matching the one specified was in the document then Parser Generator would lock up.  This has now been corrected.



3)	The argument macros that can be specified in the Arguments edit box for the Tools and Tool Arguments dialog boxes were not being substituted correctly.  Instead of replacing the macro, the relevant substitution string was inserted before the macro.



4)	The Microsoft Visual C++ specific 32-bit YACC and Lex library ylmtdll.lib was compiled incorrectly.  Instead of being compiled with the Multithreaded DLL run-time library it was compiled with the Multithreaded run-time library.



5)	The yyreject handling logic in the yylex series of functions has been revised slightly.  This is to remove warning messages that were generated by the Borland compilers.  The logic is also slightly more robust.



6)	It is now possible to specify regular expressions that match the end-of-file marker in Lex.  This is done using the <<EOF>> token.  The syntactic addition is made to the right-context expression:



right-context-expression :

	[union-expression] / union-expression

	[union-expression] $

	union-expression

	<<EOF>>



Note that the <<EOF>> token does not have a preceding union-expression rule.  This is important since the union-expression rule gives access to the characters and operators that you would normally use inside a regular expression.  In fact you can only use the leading newline operator ^, and the start state operator pair < > with the <<EOF>> token when forming a regular expression.



The length of a matched <<EOF>> regular expression string is always zero (yyleng = 0).  The end-of-file marker is effectively backed up (if you think of it as a character).  Using the right context operator, an end-of-file expression can alternatively be thought of as /<<EOF>>, although don't try this as it will generate a syntax error.



The action associated with an <<EOF>> regular expression behaves as a normal regular expression would.  The one thing to be careful of is returning a value from an action.  If you do so, then the yywrap function following the <<EOF>> handling code will not be executed.  It is possible to use yyreject in an <<EOF>> action, although it would only make sense to do so if you built the lexical analyser with the -r option.



7)	The range operator has been revised slightly to make it more flexible.  The new syntax is shown below:



range :

	{ integer , [integer] }

	{ integer }



If the second integer is omitted i.e. the range looks like {m,}, then the regular expression to the left will be matched m or more times.  If both the comma and second integer are omitted i.e. the range looks like {m}, then the regular expression will be matched m times exactly.



8)	The left context expression rules have been revised slightly to make them more flexible.  This is to allow left context to be associated with a group of regular expressions.  It is also possible to nest these groups, with all left context specified being cumulative.  The revised syntax is shown below.  Note that it is not necessarily pretty:



rule-list :

	rule-list rule

	rule



rule :

	group-rule

	expression-rule



group-rule :

	[left-context] { [rule-list] }



expression-rule :

	expression separator expression-rule

	expression action



expression :

	[left-context] right-context-expression

	

left-context :

	< start-list > [left-context]

	< * > [left-context]

	^ [left-context]



9)	Logic for the detection of non-matched regular expressions has been improved, although this is really as a consequence of the introduction of the trailing end-of-file operator <<EOF>>.  Previously, the regular expressions shown below would not have generated an unmatched regular expression warning:



a+  { do something }

a*  { do something }



In the second case a* can, in principle, match a string of zero characters, and indeed this is how the states were laid out by ALex.  However the yylex series of routines will always match a string of at least one character in length, meaning that the second regular expression will never be matched.



In the revised version of ALex, the initial starting states, where no characters have been matched are used for holding trailing end-of-file operator information.  Match information for other regular expressions, which is never used, can simply be deleted.  Note that this does not include backup information, which is always kept.



10)	The virtual C++ keyword is now syntax coloured by Parser Generator as a C++ keyword, rather than a C keyword.



11)	The Project command in the Options menu is now disabled when a build operation is being performed.



12)	Declaration code blocks %{…%} after the first %% mark in a YACC source file are now copied into the top of the parser action function.  Note that this has been working correctly in previous versions of AYACC (pre version 0.40).



13)	Start states in Lex are now copied into the generated include file when appropriate.  If an include file is not generated, then the start states are copied into the output file instead.



14)	ALex Code lines in Parser Generator are now syntax coloured.



15)	Where appropriate, any character that is not part of another token is now considered to be a regular expression character.  Previously only ASCII characters 33-126 (decimal inclusive) were considered as regular expression characters (returned by the C library function isgraph).



16)	C++ class generation support has now been added to Parser Generator.



17)	Hexadecimal integers are now recognised correctly by AYACC and ALex.



18)	AYACC now checks for token number clashes.



19)	Assigning a number to a token using a token declaration now means that any subsequently declared tokens will have a token number based on this one i.e. the first token after it will be one greater, the second two greater, and so on.



20)	All settings made in the Page Setup dialog box are now kept when the OK button is pressed.  Previously it was only the Margins that were saved.



21)	The Parser Generator Home Page command in the Help menu now works correctly with Netscape Navigator.



22)	The yysyntaxerror function is no longer called when a syntax error is generated in an action through a call to the yyforceerror or yythrowerror function.



23)	The verbose file generating code has had some corrections made to it.  The verbose file now reflects the grammar generated in the C/C++ files properly with regards to default reductions.  Also, rules with no symbols on the right hand side were not being output in the state description.



24)	AYACC and ALex now have a number of table compression options.  These are the -E, -N, -R and -S options in AYACC and the -E, -R and -S options in ALex.



Version 0.61

1)	The source files in the Borland YACC and Lex library project are now stored in a relative manner again.  In version 0.60 they became stored, erroneously, in an absolute manner i.e. all the files had, as their root, the directory C:\PARGEN\SOURCE.  This made it impossible to build any libraries if you installed Parser Generator in a directory other than the default.  In order to fix the problem it was necessary to first delete the source file references from the project, and then add them in again.



2)	The YYFAR modifier in the YACC and Lex library now does something.  It is applied to most pointers and the class definitions in the library.  If you are using a Borland compiler, then YYFAR will be defined as __far in the following conditions: 1 - you are building a static library intended to be linked to a DLL (Note that the default project supplied with Parser Generator generates static libraries which are linked to applications.  The two are not the same).  2 - you are building a Windows 3.x library i.e. not a Win32 library that does not have any segments to worry about.  And finally 3 - you have specified the small or medium memory model.  The definition of YYFAR as __far is necessary because the standard runtime library functions, in these circumstances, deal mostly with far pointers.



3)	The parser and lexical analyser driving tables, generated by AYACC and ALex are now placed in the code segment under the following extra conditions: You are building a 16-bit application with the Microsoft Visual C++ compiler and 2 - you are using a medium memory model.



4)	A couple of anachronism warnings, generated when using Visual C++ version 5 have now been removed.  The trouble was caused by the yydebug variable having the wrong modifier.  Instead of having YYDCDECL, it had YYCDECL.



5)	When generating a multiple model (C) parser using AYACC, an erroneous value was assigned to the yymdebugout member of the yymparse_t structure.  The trouble was caused by having a #ifdef statement instead of a #ifndef statement.  In most circumstances this would have lead to the assignment of NULL to the aforementioned member:



#ifndef YYMPARSEDEBUGOUT

#ifndef _DLL    // was #ifdef _DLL

#define YYMPARSEDEBUGOUT stdout

#else

#define YYMPARSEDEBUGOUT NULL

#endif

#endif



The case where _DLL is defined only occurs when you are building a 32-bit application or DLL with a Microsoft Visual C++ compiler and the runtime library is held in a DLL.  In such circumstances, when stdout is assigned to the yymdebugout member, an error is generated by the compiler.



6)	Additional file name extensions, other than .pgp, have now been registered with Windows.  The extensions added are .y, .yac, .l, .lex and .v.  .y and ,yac extensions correspond to a YACC Source File.  .l and .lex correspond to a Lex Source File, and .v corresponds to a YACC Verbose File.  Each file type gains its own icon, and it is possible to open and print the files in the usual way from Windows Explorer (and elsewhere).



7)	Character class expressions are now recognised by ALex.  They are used in character classes to specify commonly used sets of characters.  Character class expressions are delimited by [: and :], and contain a name describing the character set.  Each name typically has a corresponding function in the C run-time library which returns the character set information.  For instance, the character class expression [:alpha:] specifies all letters, and this information is specified by the isalpha function.  The character class expressions recognised by ALex are [:alnum:], [:alpha:], [:blank:], [:cntrl:], [:digit:], [:graph:], [:lower:], [:print:], [:punct:], [:space:], [:upper:], [:xdigit:].  The character set specified by [:blank:] does not have a corresponding isblank function, and in this case is assumed to consist of the space and tab characters.



8)	The yysettextsize and yymsettextsize C functions and the yylexer::yysettextsize C++ member function were not working correctly.  The problem occurred when the text and state buffers were assigned a size which was less than the initial (static) size.



9)	The omission of a semicolon from the end of a YACC rule would sometimes cause AYACC to lock up, reporting an indefinite syntax error.  This occurred if the last rule in a grammar did not have a terminating semi-colon, and there was no second %% mark to introduce the programs section.



10)	Certain attributes would cause AYACC to perform an access violation.  This would only happen if a $n attribute was used in an action which was the first symbol in a production.



11)	Certain, erroneous grammars, would cause AYACC to perform an access violation.  This was caused by a so called accept-reduce error not being handled correctly, if at all, by AYACC.  An example grammar which generates such a conflict is:



A: A ;



	This has led to the introduction of a new warning message to report when such conflicts to occur.  Note that they are extremely rare.



12)	The union generated by the %union keyword in YACC is now surrounded by a #ifndef YYSTYPE/#endif pair.  This is to allow multiple parser header files to be included in the same source file.  Previously, it was only the definition of YYSTYPE that was protected.



13)	The problems with printing in NT have now been largely sorted out.



Version 0.62

1)	Nonterminal destructors have now been upgraded to full symbol destructors.  That is, whenever a symbol, either a nonterminal or token is popped off of the stack during error recovery, then it is possible for an action to be called for that particular symbol.  It is also possible for a destructor to be called when a lookahead token is discarded during error recovery.



2)	There was a bug in the constructor for the yyparser class.  Instead of initialising the member variable yysstackptr to NULL, the constructor was erroneously initialising yystackptr to NULL twice.



3)	The Target Language option in the ALex Options dialog box now loads correctly from Parser Generator project files.  Previously, the Target Language would always be set to C when a new project was loaded.



4)	Line comments, i.e. those beginning with //… would cause the lexical analyser to misbehave under some situations in the rules section of a Lex source file.  Line comments on a line by them self were OK, however if the line comment was preceded by some other tokens, i.e a %% mark, or an expression and associated action, then the problem would present itself.  In these circumstances, the next following expression would not be recognised correctly.  The problem would resolve itself, when the next newline character was seen.



5)	The error recovery mechanism for compact parsers now works correctly.  Previously it was checking for an error action, when it should have been checking for a shift action.



6)	Debug output can now be directed to a Debug Window if the parser and/or lexical analyser is used in a 32-bit Windows application.  In order to do this it is necessary to assign the necessary debug output stream to NULL.



7)	There has been a general improvement in parser debug output.  In particular exit, throwerror, retire and error recovery attempt events are now reported.



8)	The yywipe range of functions have now been split into two variants - yywipe and yycwipe.  The former function copes with default (fast) parsers, whilst the latter function copes with compact parsers.  The split was necessary because of the introduction of token destructors.



9)	A new variant of the yyclearin function has been introduced.  In fact there are two variants - yydestructclearin and yycdestructclearin.  The first is for default (fast) parsers and the second for compact parsers.  The functions clear the current lookahead token, similar to yyclearin, however they also call the destructor for the token if one exists.  These functions are used by yywipe and yycwipe.



10)	The yywipeflg specifies whether the stack should be "wiped" whenever the parser aborts the current parse.  By default the flag is set to 1.  The wipe typically involves popping all states off of the stack, calling any symbol destructors where necessary, and destructively clearing the current lookahead token.



11)	The yydebugstack flag (and others) specifies whether the contents of the stack should be output, along with other debug information, when debug output is enabled.  By default yydebugstack is set to 0, i.e. stack contents is not output.



12)	The yydebugflush flag (and others) specifies whether the debug stream should be flushed whenever any output is written to it.  This is handy if the application crashes - under these circumstances, any data held in a steam buffer will be lost.



Version 0.63

1)	Table compression in AYACC and ALex has been revised.  This has resulted in the generated tables being slightly larger than what they were, but now faster.  This has been brought about by a change in the default state generating code.  There has also been a major revision of the goto tables generated by AYACC.  This is to reduce the size of the tables generated for a CLR parser.  Note that table sizes for an LALR parser will increase slightly.



2)	Drag and drop has been added to the editor windows.



3)	The behaviour of the cursor and the way text is selected has also been revised in the editor window.  This is to try and bring the editor into line with more modern editors.



4)	The use of the integer variable i in the yycpush.cpp source file has been revised slightly.  This is to cope with the new C++ standards that are coming out.  As such, the variable is not defined in the first loop anymore.  Instead, it is defined in the outer compound statement.



5)	Output and include file name extension options for AYACC and ALex were not always loaded correctly by Parser Generator.  This has now been corrected. 



6)	A ParserWizard dialog box has been added to Parser Generator.  This allows more information to be specified when creating a project.  In particular the wizard allows the creation of a YACC and/or Lex file.  The dialog box is displayed by selecting the ParserWizard command from the Project menu.



7)	Direct support for Borland C++Builder has been added.  There are now C++Builder libraries supplied with Parser Generator.  Note that Visual C++ version 1.52 and Borland C++ version 4.52 libraries have been removed from the main application.



Version 1.00

1)	The AYACC Options and ALex Options dialog boxes have been updated.  They now both contain a Category combo box.  This has allowed the options to be split up into a number of different, selectable panes.  It has also allowed the addition of table compression options which were previously missing.



2)	A new -z option has been added to both AYACC and ALex.  Similar changes have also been made to the AYACC Options and ALex Options dialog boxes in Parser Generator in order to support it.  The option instructs AYACC and ALex to use short file names.  This applies to any file names which are generated in the output and include files.  At present, this applies to file names that are output as part of a #include or #line directive.



3)	The line buffer size for both AYACC and ALex has been increased from 1024 characters to 2048 characters.



4)	When launching tools from Parser Generator, including AYACC and ALex, if the path name includes a space, then it is now surrounded by double quotes.  This is to ensure that the correct tool is run.



5)	The setup utility now places double quotes around all path names, where necessary, when placing them in the registry.  Previously, the setup utility was correctly double quoting path names for entries in the start menu, however it was not doing the same when registering PARGEN.EXE with the file name extensions .y, .yac, .l, .lex and .v.



6)	The default installation directory for Parser Generator has been changed from c:\pargen to C:\Program Files\Parser Generator.  Note that this is assuming that c is the drive on which the operating system is installed.



7)	The yydestructclearin series of functions were not working correctly.  That is, the functions yydestructclearin and yymdestructclearin and the member function yyfparser::yydestructclearin.  They were not making use of the token destructor base variable when assessing whether a token destructor action needed to be performed or not.  Note though that trouble could only occur if there was at least one token destructor action in the parser.



8)	The Microsoft Visual C++ specific 32-bit YACC and Lex library ylmtdll.lib was compiled incorrectly again!  It is now compiled with the Multithreaded DLL run-time library, and hopefully it'll stay that way.



9)	The ParserWizard in Parser Generator was not working correctly.  When a C++ parser and lexical analyser were created, the resultant YACC source file would not compile correctly.  Note that this was only in cases where a main function was generated.  The trouble was caused by the declaration of the lexical analyser local variable appearing too late in the main function.  It occurred after it was referred to in the yyparser::yycreate member function.  The declaration of the lexical analyser local variable has now been moved up in the function to rectify the problem.



Version 1.10

1)	The Parser Generator Home Page command in the Help menu should now work in all cases.  This is for definite.



2)	Table declarations were not affecting character classes.  That is, the character class [ABC] would represent the characters 65, 66 and 67, no matter what was specified in a table declaration.  Note that characters and character strings were being properly mapped according to any table declarations which might have affected them.



3)	YACC, Lex and Verbose file icons are now associated with the files in Windows Explorer no matter what directory Parser Generator is installed in.  Previously, if Parser Generator was installed in a directory containing a space (say C:\Program Files\Parser Generator), then no icons would have been associated with the files.  Actually, the setup utility would have made the associations correctly, but then Parser Generator would have messed them up when it was run.



4)	A call of Sleep(0) is now made directly after every call to OutputDebugString in the YACC and Lex library.  This is to ensure that all debug strings are processed by whatever is intercepting them.  For instance, if this call is not made then Visual C++ will lose debug output after a certain number of characters have been generated and the program has not hit a breakpoint or terminated.



5)	A Project window has now been added to Parser Generator.  This replaces the previous Add Project dialog box.  Files are now added to the project through the Add Files command in the Project menu.  Files are deleted from the project by selecting the relevant file in the Project window and either pressing the delete key, selecting the Delete command from the Edit menu, or selecting the Delete command from the pop-up menu.



6)	The way lines are drawn in the editor windows have been refined.  This is to hopefully fix some situations where tab characters are not drawn correctly.



7)	The yythrowerror member function of the yyparser class has been revised slightly.  It now takes a default argument of 0 if one is omitted i.e. it is treated exactly the same as the yyforceerror member function.



8)	YYNINITSTREAM is now defined for all versions of the Borland C++ compilers whenever the runtime library is held in a DLL.  Previously, it was only defined for compilers with a version number (__BORLANDC__) greater than or equal to 0x0530.



9)	There are now two more YACC and Lex libraries supplied with Parser Generator to support Borland C++Builder.  These are yldll.lib and yldlld.lib.  They are respectively, single-threaded release and debug versions of the library with the run-time library residing in a DLL.



10)	The single-threaded Borland C++Builder YACC and Lex libraries yl.lib and yld.lib are now compiled correctly.  Previously, they were compiled as multithreaded libraries.



Version 1.11

1)	ALex no longer reports a reversed character class range warning when the two characters in the range have the same value.  For instance, the character class [a-a] would have generated such a warning. 



2)	A couple of memory leaks associated with project file information in Parser Generator have been removed.



3)	Double clicking on a file in the Project window in Parser Generator now sets the focus to the opened file.  Previously, the focus would have remained in the Project window, even though the file was now considered the active window.



4)	The yydestroy member functions of the yyparser and yylexer classes now set the relevant member variables to NULL, when the memory that they point to is freed.  Because yydestroy is called by the destructors as part of clean up, an explicit call to these member functions in a program would cause problems.  Setting the variables to NULL resolves this issue.



5)	The line buffers for AYACC and ALex have now been increased again.  This time from 2K to 10K.  This is mainly for ALex’s benefit though, so that it has more macro expansion space.



6)	There was a bug in the generation of compact tables in ALex.  A transition would not always contain the correct destination state.  This has now been corrected.  Note that the bug did not affect the generation of fast tables.



7)	The YACC %binary keyword is now properly syntax coloured by Parser Generator.



8)	If a macro translation token was found without a terminating right bracket }, then the non-bracketed character was included in the macro translation.  This has now been fixed, and the lexical analyser correctly backs up the character.



9)	String constants "…" and character constants '…' were not being properly recognised in declaration code blocks {…} in both AYACC and ALex.  In each case, a string constant was assumed to start with a double quote " and end with a single quote ', and a character constant was assumed to start with a single quote ' and end with a double quote ".



10)	The lexical analyser compact transition table processing code in the YACC and Lex library was not working correctly.  To be more exact, it was not dealing with default states properly.  This should now be fixed.



Version 1.12

1)	The ALex %exclusive keyword is now correctly syntax coloured by Parser Generator.



2)	The C++ keywords that are syntax coloured by Parser Generator have also been revised.  The keywords are now taken from the latest specification of C++.



3)	Some macros in the YACC and Lex conversion files, namely MYCONV.H, MIYCONV.H, MLCONV.H and MILCONV.H were wrong and have now been corrected.  Note that the erroneous macros all caused C/C++ compiler errors, so could not have caused invalid operation of a parser or lexical analyser.



4)	There was a bug in the generation and operation of compact lexer tables.  This bug did not affect fast tables.  The problem centred on the inclusion of "error" transitions in the table when compressing them.  The presence of one of these transitions would cause subsequent transitions to be lost, i.e. it would act as a terminator.  This problem has now been corrected.



5)	Compatibility for the Lex input, output and unput functions has been revised slightly.  Now all code concerning them is placed in the generated output files, including that from the conversion files.



6)	Generated C++ parser and lexical analyser classes now have a YYDECLSPEC modifier placed before them.  This is intended to make it easier to export (and import) them from a DLL.



7)	If either AYACC or ALex encounters an error now they both return an error code of 1.  Previously, they were returning an error code of 0.  Note that this does not apply to fatal errors that were causing the tools to return correctly with a 1 anyway.



8)	The Save and Save As commands in the File menu are now disabled when the Project window is active.



Version 1.90

1)	First release of pre-version 2.00 code.  Version 2.00 includes support for Multibyte character sets (MBCS), Unicode and Java.  Note that multibyte character sets are also referred to as double byte character sets (DBCS).  This release only included AYACC and ALex and the revised YACC and Lex libraries.



Version 1.91

1)	Second release of pre-version 2.00 code.  This version includes Parser Generator itself and a setup utility.  Online help though is not complete.  There have also been some modifications to AYACC and ALex as well.



Version 1.92

1)	Third release of pre-version 2.00 code.  This version includes a LibBuilder utility in Parser Generator for creating C/C++ YACC and Lex libraries.  The various Options dialog boxes have been revised so that they now reside in a single tabbed dialog box.  Online help is more complete.



Version 1.93

1)	The PGSPAWN.EXE program that is used for running the AYACC and ALex tools from Parser Generator was not working correctly in Windows 95.  This has been corrected.



2)	The default fonts for the Source, Output and Project windows were not retrieved by Parser Generator correctly in Windows 95.  This has been corrected.



Version 1.94

1)	LibBuilder revised slightly to make it easier to use and less error prone.



2)	The naming of certain functions, structures and variables in the C/C++ YACC and Lex library have been revised slightly.  This is to make them more meaningful.  Note that there are #define's to convert old names to new names to avoid portability issues.  The default yymgettoken function has also been revised to make use of the new yymlexerptr member of the yymparser_t structure.  Be careful of this.



3)	The Lex verbose file has been revised slightly.  It now displays the actual regular expressions at the top of the file, rather than ancillary information about the expressions.



4)	All generated files, that is output, include and verbose files now have a banner placed at the top of the file.  This specifies what source file it was generated from, the creation time and date and what version of the specified tool was used to generate it.



5)	Registration information has been made more prominent.  It is now added (to a greater or lesser extent) to the generated files and to the splash screen.  The 30 day trial period has also been made more visible.  That is a counter is started the first time that the program is used and counts up from that point onwards.



Version 1.95

1)	The %data keyword has been renamed as the %byte keyword.  Correspondingly, the <<DATA>> operator has been renamed as the <<BYTE>> operator.



2)	The error token in AYACC is no longer associated with the un-typed symbol destructor.  If you want to assign a destructor to the error token then you will need to do it explicitly.



3)	ALex now correctly looks up the ANSI and OEM code pages.  As such there are no longer potential character conversion problems if you explicitly specify the ANSI code page using the %codepage keyword with a trailing code page number.  Previously, ALex would convert the character to Unicode and then convert it back to its ANSI code page equivalent again.



4)	There was a table generating error in AYACC.  Basically, default reductions were not being migrated down to default states when they were introduced.  This problem has now been fixed.  Note that this problem only really affected Unicode parsers (which have far greater token ranges).



5)	A [:trailbyte:] character class expression has been added to ALex.  This specifies the valid trail bytes of a multibyte character.  If the selected code page is a multibyte code page, then this expression specifies the characters 0x01 to 0xFF, otherwise it is empty.  The CCExpr utility has also been updated to support the new character class expression.



6)	The [:leadbyte:] character class expression is now recognised by the CCExpr utility.



7)	Printing now works correctly in Parser Generator if the document is more than one page long.  Previously, Parser Generator would spool a large number of blank (or nearly blank) pages.



8)	The #ifndef/#endif directives surrounding the yytdefs.h and yybdefs.h header files have now been removed.  They were erroneously added in version 1.94.



9)	An unnecessary #pragma option -a- directive has been removed from the Borland C++/Borland C++Builder options in the yytdefs.h header file.



10)	The LibBuilder settings for the Borland C++, Borland C++Builder and Visual C++ (16-bit) compilers have been revised slightly so that they are capable of generating libraries under Windows 95 (and associated operating systems such as Windows 98 and Me).  Note that the settings worked fine for Windows NT.  The trouble was caused by long to short path name conversion and differences in implementation between the two sets of operating systems.



Version 1.96

1)	In some places in the C++ parser classes, notably yycreate and yydestroy, attribute memory deletion was performed by treating the attribute as a character array and deleting it using a delete statement.  This was the old style of doing things.  The attributes should have, and now are, deleted with a call to the yydeleteattribute member function.



2)	The yydestroy member functions in the C++ parser and lexer classes can now be called multiple times without undesirable effects (like causing a crash).  Note that yydestroy is called automatically from the destructor.



3)	An (optional) destructor declaration code block has now been added to the name declaration.  The declaration code block follows the one for the constructor.  It has been necessary to add this because the call to yydestroy in the default C++ parser destructor cannot call the overridden yydeleteattribute member function correctly.  Instead it is necessary to place a call to yydestroy in the derived classes destructor.  Note that whilst it is not necessary to do this for the lexer C++ classes, it is still possible to specify a destructor declaration code block.



4)	The redundant -t option has been removed from ALex.



5)	The yydestroy methods in the Java classes now set all memory references to null.  Previously, some were still left pointing to objects.



6)	The Java parser classes have been made a bit more efficient.  As such they now do not do quite so much cloning, newing and “deleting” of attribute objects.



7)	AYACC no longer generates spurious yyaction termination code if the second %% mark introducing the programs section is omitted.



8)	The contents of the Lex . character class now depends upon the selected mode.  Previously, the contents were generated as if character mode was always selected.



9)	AYACC now deletes the generated verbose file if an error occurs.



10)	The -d option in AYACC is now implemented as the -i option.  This is to match ALex which also uses the -i option to generate an include file.  Parser Generator compensates for this by automatically converting a -d option in a project to a -i option.



11)	The line buffers for AYACC and ALex have now been reduced back to 2K in size from 10K.  However, the macro expansion buffer for ALex is now 64K in size.



Version 1.97

1)	If Parser Generator is activated, and files have been externally modified, the application is first restored before you are prompted to reload the files.  Previously, you would be prompted first and then the application would have been restored.  Additionally, if the application was minimised, then the restore would never have taken place.



2)	When AYACC and ALex are generating C/C++ and Java strings in the output files, characters below 128 which do not correspond to a graphic or an escape character are now output using octal encoding \ooo, rather than as is.



3)	File names in the generated #include and #line C/C++ directives now use relative path names where ever possible.  Otherwise, they will use a full path name.  Previously, generated #include directives always contained a file name, that is, there was never any directory information present.  The generated #line directives always contained a file name which corresponded to the source, output or include file name specified on the command line.  In both directive cases, it was possible for the wrong file name to have been output, especially when directories are traversed.



4)	Token destructor array generation for fast parsers was not working correctly.  The tables would include match entries for tokens with no associated destructor.  Although there was no destructor action (-1) associated with the entry, this would be caught by an assertion in the (C/C++) YACC and Lex library.



5)	The line number and column panes in the status bar are now updated correctly when jumping from an error in the output window to the relevant line in the source file.  Previously, the line number and column panes would remain set to the cursor position in the Output window.



6)	The YACC and Lex libraries now come in DLLs, as well as static link libraries.  Note that due to certain constraints single model C parser and lexer library code has not been placed in the DLLs.  As such, if you want to use these types of parsers and lexers then you will need to use the static link libraries.  However, the main reason for having the libraries in a DLL is to be able to easily generate C++ parsers and lexers which are themselves contained in DLL.



7)	Library support for Borland C++Builder has been improved.  There are now YACC and Lex libraries which both support, and do not support, the VCL.



8)	The variable declarations in the generated include files for multiple model C parsers and lexers are now wrapped in extern "C" declarations if __cplusplus is defined.  This should allow the parsers and lexers to be more easily used in a C++ environment.



9)	The Replace command in the Edit menu of Parser Generator was not working correctly.  Basically, there was a document indexing problem when performing replace operations.  This has now been corrected.



10)	The include files generated for C++ Unicode lexers now include _YL specifiers before the yywint_t type.  If this is not present then there can be namespace problems, especially if the generated lexer header file is included in another source file and a using namespace yl statement is not present.



11)	The output of strings to Java parsers and lexers has been revised.  Previously, output was treated more or less the same as that for C/C++.  However, C/C++ has some escape sequences that are not present in Java, namely \v, \a and \?.  As such, these have been removed from Java string output.



12)	When generating Java parsers, an unnecessary semicolon ';' placed at the end of the YYSTYPE class has been removed.



13)	There have been some slight revisions to ParserWizard output, most notably the addition of YYFAR modifiers at the appropriate points.



14)	When generating Java parsers, if a union or token declaration precedes a name declaration then an error is generated.  The code emitted from a union or token declaration must reside within the new derived class.  Similarly, when generating Java lexers, if a start state declaration precedes a name declaration then an error is also generated.



15)	Attributes in ALex actions which contained a tag i.e. $<…>$ or $<…>n were being incorrectly processed.  This has now been corrected.



Version 1.98

1)	The LibBuilder utility in Parser Generator has been modified.  Basically, the dialog based approach has been replaced with a script file approach.  Whilst more complicated, this has a number of advantages over the previous implementation.  It allows faster compilation, and the ability to easily generate command files.  This last point is particularly relevant to older versions of Windows - the 9x range, where there are typically command line length limits.



2)	The type declaration in AYACC now supports character tokens, as well as identifiers.



3)	The default font for the Project window has now been changed.  This should hopefully prevent it from disappearing from the Font combo box in the Options dialog box.



4)	The debug version of the YACC and Lex library DLL can now be attached to an application using deferred loading.  That is through a call to the Win32 LoadLibrary function from within the application.  The problem was caused by __declspec(thread) marked variables.  The solution was to use critical sections to protect the variables, and then only allow access to them through functions.



5)	The ESCAPE key now works correctly in Parser Generator under Windows XP.  Previously it would clear the current selection and insert a strange character.  Now it simply clears the selection.



Version 2.00

1)	It is no longer necessary to use quotes around file names containing spaces in the New Project dialog box.  Previously, if you did not do this, then the file name was rejected as invalid.



2)	The driving tables for Java parsers and lexical analysers are now stored in a static (class) member variable.  This means that at most one set of tables will be created, no matter how many parsers and lexers are in existence at any one time.



3)	The yyparser::yythrowerror and yywparser::yythrow member functions now have 0 as their default values.



4)	Generated C++ lexical analysers now have YYEXPLEXER modifiers, rather than YYEXPPARSER modifiers.  These modifiers are intended to make it easier to export the class from a DLL.



Version 2.01

1)	The "you are on day n of your 30 day trial period." message in the splash screen is now no longer displayed if you are a registered or an academic user.  Furthermore, if you have been using Parser Generator for longer than 30 days, then you will no longer need to click on the splash screen in order to close it.



2)	Support for Microsoft Visual C++ version 7.0 (Visual Studio .NET) has been added to the LibBuilder utility.



3)	The yygetglobaldebug, yysetglobaldebug, yygetglobaldebugstack, yysetglobaldebugstack, yygetglobaldebugflush and yysetglobaldebugflush functions are now defined as inline functions, rather than as macros, when the global.h headed file is included in a C++ file.



4)	An Insert File into Project command has been added to the Editor pop-up menu.  This adds the active file to the currently open project.



Version 2.02

1)	The token destructor table for fast parsers was not always generated correctly.  This has now been corrected.



2)	The Lex range operator {m[,[n]]} now works correctly if m or n are zero.  Previously, any value of zero would have been treated as a value of one instead.



3)	The case insensitive -u option for ALex was not working correctly.  For characters and character classes it would add the corresponding upper and lower case letters where necessary.  For character strings however, it would not.  This has now been corrected.



Version 2.03

1)	The size of the ALex input line buffer has been reduced from 10K to 2K, as it should have been originally.  The macro expansion buffer remains at 64K.



2)	There was an additional case insensitive bug which has now been corrected.  This error would only occur if the -u option was specified on the command line, and revolved around an un-initialised variable.



Version 2.04

1)	The end-of-file operator <<EOF>> was not being parsed correctly by ALex.  It would accept input with the <<EOF>> operator at the end of regular expressions.  This should not really be possible.  The <<EOF>> operator can only really exist on its own, and not part of another regular expression.  This has now been corrected.  Note that if these erroneous regular expressions occurred in previous versions of ALex, then the regular expression prior to the <<EOF>> operator was simply discarded.



Version 2.05

1)	Regular expressions containing a start-of-line operator were displayed in the Lex verbose file with a tilde '~' sign, rather than a circumflex '^'.  This has now been corrected.



Version 2.06

1)	Erroneous 's' characters were output in the summary section of the YACC verbose file.  This occurred if a state contained more than one accept-reduce, shift-reduce or reduce-reduce error.  In which case, the summary of the errors would contain an unnecessary 's' at the end of the line.  This has now been corrected.



2)	An unused yygvars.c file has been removed from the C++ YACC and Lex library source directory,



3)	Improved Borland C++Builder support has been added to the LibBuilder.  It should now be possible to rebuild the libraries using Borland C++Builder version 6.



4)	The LibBuilder script file for Borland C++ contained an error when building large model DOS libraries.  They were erroneously being built as compact libraries.  This has now been corrected.  A number of extra libraries have also been added to improve Win32 support.



5)	The LibBuilder script file interpreter can now recognise logical AND operators && correctly.  Previously, they would cause a syntax error to occur.



Version 2.07

1)	It was possible for AYACC to produce erroneous Y4012 warnings stating that symbols were never being pushed onto the stack.  This problem has now been corrected.





2
)	
The behaviour of 
stack 
symbol destructors
 ha
s bee
n revised slightly.  Now, 
if a symbol is to be popped off of the stack, 
the attribute associated with symbol is first copied to the $$ attribute
.  T
he symbol is then popped 
and 
the destructor action is performed.  
Unlike previously, t
he $$ attribute is no longer copied back to the stack
.  A
fter all the symbol has already been popped off of the stack, and th
ere is nothing to copy back to.
  The 
$0
 attribute now refers to the topmost symbol on the stack.






3
)	
Tab indenting 
of text 
in Parser Generator 
would 
sometimes 
cause
 Parser Generat
or to crash.  This only occu
rred
 when indenting a large block
 
of text 
and the undo buffer 
wa
s
 not large enough to contain the operation.  This 
has now been corrected.  Note 
that tab indenting is performed
 by selecting a block of text and pressing TAB (or SHI
FT+TAB to un-
indent)
.





End of Release Notes



